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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Barres d'outils et menus

Pour modifier les attributs d'un objet, comme sa couleur ou la largeur de sa bordure par exemple, 
vous pouvez utiliser la barre d'outils Ligne et remplissage, la barre d'outils Formatage du texte ou 
le menu contextuel d'un objet.

Barre d'outils Ligne et remplissage
Si la barre d'outils Ligne et remplissage (Figure 1) n'est pas affichée, allez dans Affichage > 
Barres d'outils > Ligne et remplissage. Les attributs les plus usuels d'un objet peuvent être 
modifiés au moyen de cette barre d'outils. Vous pouvez accéder à des informations 
supplémentaires en cliquant sur l'icône Ligne pour accéder à la boîte de dialogue Ligne, ou en 
cliquant sur l'icône Remplissage pour accéder à la boîte de dialogue Remplissage.

Figure 1 : Barre d'outils Ligne et remplissage

Les outils disponibles dans cette barre d'outils, de gauche à droite, sont listés Figure 2.

Figure 2 : Outils de la 
barre d'outils Ligne et 
remplissage
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Barre d'outils Formatage du texte
Lorsque vous sélectionnez un texte, la barre d'outils Ligne et formatage est remplacée par la barre
d'outils Formatage du texte (Figure 3). Vous pouvez également la faire apparaître en choisissant 
Affichage > Barres d'outils > Formatage du texte. Les outils de cette barre d'outils ne seront 
disponibles que lorsqu'un texte aura été sélectionné.

Figure 3 : Barre d'outils Formatage du texte

Les outils disponibles dans cette barre d'outils, de gauche à droite, sont listés Figure 4.

Figure 4 : Outils de la barre d'outils Formatage du texte
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Menu contextuel d'un objet

Figure 5 : Menu contextuel d'un objet

Lorsque vous sélectionnez un objet et que vous faites un clic droit, un menu contextuel s'ouvre 
(Figure 5). Ce menu vous permet d'accéder à des commandes destinées à modifier les attributs de
l'objet sélectionné. Les éléments du menu qui comportent un petit triangle noir à leur droite 
donnent accès à un sous-menu.

Formater des lignes

Dans LibreOffice, le terme de ligne s'applique à un segment indépendant (ligne), au bord extérieur 
d'une forme (bordure) ou à une flèche. Dans la plupart des cas, les propriétés d'une ligne que vous
allez modifier sont son style (continu, tirets, pointillés, invisible…), sa largeur et sa couleur. 

Attention
L'outil Largeur permet de définir l'épaisseur du trait. Ne pas confondre avec la 
largeur (longueur du trait) définissable dans le dialogue Position et taille.

Vous pouvez effectuer rapidement les modifications en sélectionnant la ligne et en utilisant les 
outils de la barre d'outils Ligne et remplissage (Figure 6).

Figure 6 : Style, largeur et couleur d'une ligne

Si vous avez besoin de régler plus finement les attributs d'une ligne, vous pouvez le faire dans la 
boîte de dialogue Ligne. Pour y accéder, sélectionner la ligne et choisissez Format > Ligne dans 

la barre de menus, cliquez sur l'icône Ligne  de la barre d'outils Ligne et remplissage, ou faites 
un clic droit et choisissez Ligne dans le menu contextuel. La boîte de dialogue Ligne comporte 
quatre onglets : Ligne, Ombre, Styles de lignes et Styles de flèches. L'onglet Ombre n'est pas 
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accessible pour les bordures de formes : vous pouvez y accéder à partir de la commande 
Remplissage.

Figure 7 : Onglet Ligne

Propriétés de la ligne
L'onglet Ligne (Figure 7) est l'endroit où sont gérés les paramètres de base d'une ligne. Il est 
divisé en quatre sections.

Section Propriétés de la ligne

Style
Plusieurs styles de lignes sont disponibles dans la liste déroulante (Figure 8). Des styles 
supplémentaires peuvent être définis si nécessaire.

Figure 8 : Styles de ligne
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Couleur
Choisissez une couleur parmi les couleurs prédéfinies dans la liste déroulante.

Largeur
Saisissez la largeur de la ligne souhaitée. L'unité de mesure par défaut est celle indiquée dans 
Outils > Options > LibreOffice Draw > Général, mais vous pouvez saisir une autre unité. Si 
cette valeur est nulle, la ligne résultante a une largeur minimale d'un pixel.

Transparence
Saisissez le pourcentage de transparence de la ligne. La Figure 9 montre l'effet de différents 
pourcentages de transparence lorsque des lignes sont placées au-dessus d'un objet.

Figure 9 : Différentes valeurs de 
transparence (0%, 25%, 50% et 
75%, de gauche à droite)

Section Styles de flèche
Les paramètres de la section Styles de flèche ne s'appliquent qu'aux lignes individuelles et n'ont 
aucun effet sur les lignes qui constituent la bordure d'une forme.

Style
Choisissez le style des deux extrémités de la ligne. La liste déroulante de gauche vous permet 
de choisir le style du début de la ligne et la liste déroulante de droite de choisir le style de la fin 
de la ligne.

Vous pouvez modifier plus rapidement le style d'une extrémité de la ligne en utilisant l'icône 

Style de flèche  de la barre d'outils Ligne et remplissage et en choisissant un style dans la 
barre d'outils Extrémités de flèche (Figure 10), à gauche pour le début et à droite pour la fin de 
la ligne.

Figure 10 : Barre d'outils Extrémités de flèche
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Attention
L'option Synchroniser les extrémités ne s'applique pas si vous utilisez l'icône Style 
de flèche.

Largeur
Saisissez les largeurs de flèche souhaitées aux deux extrémités de la ligne, si un style de 
flèche a été choisi. L'unité de mesure par défaut est celle indiquée dans Outils > Options > 
LibreOffice Draw > Général, mais vous pouvez saisir une autre unité. Si cette valeur est nulle,
la flèche disparaîtra.

Centre
Déplace le centre de la flèche de l'extrémité correspondante vers le point d'extrémité (à 
l'endroit où la ligne se termine). La Figure 11 montre l'effet de cette option.

Figure 11 : Flèches par défaut 
(en haut) et centrées (en bas)

Synchroniser les extrémités
Une fois cette option cochée, si vous modifiez un attribut d'une extrémité dans cette section, 
l'attribut correspondant de l'autre extrémité de la ligne sera modifié de la même façon.

Attention Le simple fait de cocher l'option Synchroniser les extrémités ne va pas rendre 
identique les deux extrémités de la ligne. Il faut que vous modifiiez un attribut pour 
que ses valeurs soient identiques pour le début et la fin de la ligne.

Section Style d'angle et de coiffe
Le style d'angle détermine la façon dont s'effectue la jonction entre deux segments. Les styles 
Arrondi, - aucun -, En onglet et Biseauté sont disponibles. Pour comprendre la signification des 
différents styles d'angle, augmentez la largeur de la ligne et observez leur effet dans l'aperçu de la 
ligne.

Le style d'extrémité détermine la forme des extrémités de chaque ligne. Les styles Plat, Arrondir et 
Carré sont disponibles. Procédez comme pour les styles d'angle pour comprendre leur 
signification.

Section Aperçu
Cette section, située en base de la boîte de dialogue, vous permet d'avoir un aperçu de la ligne et 
de ses styles d'angle et d'extrémité, au fur et à mesure que vous modifiez les paramètres de 
l'onglet Ligne.

Ombre
L'onglet Ombre (Figure 12) est l'endroit où vous pouvez ajouter et formater une ombre à la ligne 
sélectionnée. Le contenu de cet onglet est identique à celui s'appliquant aux objets et est décrit 
dans "Ombre" page 21.
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Figure 12 : Onglet Ombre

Vous pouvez appliquer rapidement une ombre à la ligne sélectionnée en utilisant l'icône Ombre

 de la barre d'outils Ligne et remplissage. Cependant, l'ombre appliquée ne sera que celle 
définie par défaut.

Styles de lignes
L'onglet Styles de lignes (Figure 13) est l'endroit où vous allez pouvoir créer de nouveaux styles de
ligne et charger des styles préalablement enregistrés. Il est préférable de créer de nouveaux styles
plutôt que de modifier des styles prédéfinis.

Figure 13 : Onglet Styles de lignes
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Créer un style de ligne
Pour créer un style de ligne à partir de cet onglet :

1) Choisissez dans la liste déroulante Style de ligne un style proche de celui que vous voulez 
créer.

2) Cliquez sur Ajouter. Dans la boîte de dialogue Nom qui s'ouvre, saisissez le nom du 
nouveau style de ligne et cliquez sur OK.

3) Définissez le nouveau style. Commencez par choisir le type de composant de la ligne 
(Point ou Tiret). Vous pouvez alterner ces composants en choisissant deux types 
différents dans les deux zones du type de ligne.

4) Saisissez le nombre et la longueur de chacun des composants de la ligne. La longueur 
n'est pas disponible pour un composant de type Point.

5) Saisissez l'espacement entre les différents composants.

6) Vous pouvez cocher l'option Adapter à la largeur de la ligne.

Le nouveau style de ligne ainsi créé n'est disponible que dans le document en cours. Si vous 

voulez l'utiliser dans d'autres documents, cliquez sur l'icône Enregistrer les styles de lignes  
et saisissez un nom de fichier dans la boîte de dialogue Enregistrer sous qui s'ouvre. Le fichier a 
une extension .sod et comprend la liste active des styles de ligne.

Pour utiliser des styles de ligne préalablement enregistrés, cliquez sur l'icône Charger les styles 

de ligne  et sélectionnez un fichier dans la boîte de dialogue Ouvrir qui s'ouvre. Cliquez sur 
Ouvrir pour charger la liste des styles dans votre document.

Attention
Un bug peut empêcher le chargement des styles de lignes. Ce bug est résolu à partir
de la version 4.0.5.

Si nécessaire, cliquez sur le bouton Modifier pour modifier le nom du style de ligne.

Styles de flèches
L'onglet Styles de flèches (Figure 14) est l'endroit où vous allez pouvoir créer et modifier des styles
de flèche et charger des styles préalablement enregistrés.
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Figure 14 : Onglet Styles de flèches

Créer un style de flèche
Pour créer un style de flèche à partir de cet onglet :

1) Dessinez tout d'abord la forme que vous voulez utiliser comme pointe de flèche. Le 
sommet de la forme doit se trouver vers le haut, comme Figure 15, parce qu'il va devenir la
pointe de la flèche.

Figure 15 : Utiliser une forme
comme pointe de flèche

2) Sélectionnez la forme et, si nécessaire, convertissez-la en courbe avec Convertir > En 
courbe. Si la forme est déjà une courbe, la commande ne sera pas disponible.

Note

La pointe de flèche doit être une courbe, c'est-à-dire quelque chose que vous pouvez

tracer sans lever le crayon du papier. Par exemple, une étoile  peut être une 

courbe, mais une frimousse  ne peut pas l'être. Le bouton Ajouter ne sera pas 
actif si l'objet sélectionné n'est pas du bon type.

3) Dans l'onglet Styles de flèches, cliquez sur le bouton Ajouter, saisissez le nom du nouveau
style de flèche et cliquez sur OK. Le nouveau style de flèche va s'afficher dans l'aperçu en 
bas de la boîte de dialogue.

Vous pouvez alors choisir ce style de flèche dans la liste déroulante.
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Le nouveau style de flèche ainsi créé n'est disponible que dans le document en cours. Si vous 

voulez l'utiliser dans d'autres documents, cliquez sur l'icône Enregistrer les styles de flèche  
et saisissez un nom de fichier dans la boîte de dialogue Enregistrer sous qui s'ouvre. Le fichier a 
une extension .soe et comprend la liste active des styles de flèche.

Pour utiliser des styles de flèche préalablement enregistrés, cliquez sur l'icône Charger les styles 

de flèche  et sélectionnez un fichier dans la boîte de dialogue Ouvrir qui s'ouvre. Cliquez sur 
Ouvrir pour charger la liste des styles dans votre document.

Si nécessaire, cliquez sur le bouton Modifier pour modifier le nom du style de flèche.

Formater le remplissage

Le terme de remplissage fait référence à l'intérieur d'un objet, qui peut être d'une couleur uniforme,
en dégradé, avec un motif de hachure ou constitué d'une image bitmap (Figure 16). Le 
remplissage d'un objet peut être partiellement ou totalement transparent et projeter une ombre.

Figure 16 : Différents types de remplissage

La barre d'outils Ligne et remplissage (Figure 17) contient les outils le plus habituellement utilisés 
pour formater des objets. Sélectionnez tout d'abord un objet. Choisissez ensuite un des types de 
remplissage (Figure 18), puis, dans la liste déroulante de droite, choisissez un remplissage 
prédéfini.

Figure 17 : Type et remplissage d'un objet

Figure 18 : Types de remplissage

Si vous avez besoin de régler plus finement les attributs de remplissage d'un objet, vous pouvez le
faire dans la boîte de dialogue Remplissage. Pour y accéder, sélectionner l'objet et choisissez 

Format > Remplissage dans la barre de menus, cliquez sur l'icône Remplissage  de la barre 
d'outils Ligne et remplissage, ou faites un clic droit et choisissez Remplissage dans le menu 
contextuel. L'onglet Remplissage vous permet d'appliquer des remplissages prédéfinis, fournis par 
LibreOffice ou créés par vous ou d'autres utilisateurs. Les onglets Couleurs, Dégradés, Hachure et
Bitmap vont vous permettre de créer vos propres remplissages.
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Onglet Remplissage
Pour appliquer un remplissage, choisissez tout d'abord le type de remplissage dans la liste 
déroulante du haut. Ce choix va modifier le contenu de l'onglet.

Choisissez le type Aucun(e) pour obtenir un objet vide. Ce choix correspond à Invisible dans la 
liste déroulante de la barre d'outils Ligne et remplissage (Figure 18).

Un aperçu est disponible en bas de la boîte de dialogue et va refléter les choix que vous avez 
effectués.

Couleur

Figure 19 : Remplissage de type Couleur

Sélectionnez une couleur dans liste déroulante des couleurs disponibles (Figure 19). Cliquez sur 
OK pour que la couleur choisie devienne la couleur de remplissage de l'objet sélectionné.
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Dégradé

Figure 20 : Remplissage de type Dégradé

Choisissez un dégradé dans liste déroulante des dégradés disponibles (Figure 20). Si vous 
décochez l'option Automatique, vous pouvez choisir le nombre de pas (incréments) du dégradé, 
comme l'illustre la Figure 21. Cliquez sur OK pour que le dégradé choisi devienne le dégradé de 
remplissage de l'objet sélectionné.

Figure 21 : Dégradé automatique (de pas 64) à gauche 
et de pas 4 à droite
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Hachure

Figure 22 : Remplissage de type Hachure

Sélectionnez une hachure dans liste déroulante des hachures disponibles (Figure 22). Par défaut, 
l'option Couleur de remplissage est décochée et vous pouvoir voir par transparence à travers les 
hachures. Vous pouvez cocher cette option et choisir une couleur d'arrière-plan dans la liste 
déroulante (Figure 23). Cliquez sur OK pour que la hachure choisie devienne la hachure de 
remplissage de l'objet sélectionné.

Figure 23 : Hachure sans couleur de remplissage à gauche
et avec une couleur de remplissage jaune à droite
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Image Bitmap

Figure 24 : Remplissage de type Bitmap

Sélectionnez une image bitmap dans liste déroulante des images disponibles (Figure 24). Des 
paramètres de taille, de position et de décalage sont disponibles et sont décrits Tableau 1. Cliquez 
sur OK pour que l'image bitmap choisie devienne l'image de remplissage de l'objet sélectionné.

Tableau 1. Propriétés du remplissage de type bitmap

Propriété Signification

Taille – Original Conserve la taille d'origine de l'image bitmap.

Taille – Relatif Permet de redimensionner l'image relativement à l'objet.

Taille – Largeur Largeur de l'image. Si Relatif est coché, une largeur de 100 % 
indique que l'image aura la même largeur que l'objet qu'elle remplit. 
Une largeur de 50 % indique que l'image aura une largeur deux fois 
moindre que l'objet.

Taille – Hauteur Hauteur de l'image. Si Relatif est coché, une hauteur de 100 % 
indique que l'image aura la même hauteur que l'objet qu'elle remplit. 
Une hauteur de 50 % indique que l'image aura une hauteur deux fois 
moindre que l'objet.

Position – Carte d'ancrage Indique à quel point de l'objet l'image sera ancrée.

Position – Juxtaposer Si Juxtaposer est coché, l'image sera juxtaposée pour remplir la zone
et aura la taille indiquée dans la section Taille.

Position – Décalage X Si Juxtaposer est coché, indique en pourcentage le décalage en 
largeur de l'image bitmap. Une valeur de 50 % indique que le milieu 
de la largeur de l'image bitmap est placé au point d'ancrage et que la 
juxtaposition continue ainsi.
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Propriété Signification

Position – Décalage Y Si Juxtaposer est coché, indique en pourcentage le décalage en 
hauteur de l'image bitmap. Fonctionne comme Décalage X.

Position – Adapter 
automatiquement

Étire l'image pour remplir toute la zone de l'objet. Les paramètres de 
taille sont alors ignorés.

Décalage – Ligne Si Juxtaposer est coché, décale les lignes paires du pourcentage 
indiqué à côté.

Décalage – Colonne Si Juxtaposer est coché, décale les colonnes paires du pourcentage 
indiqué à côté.

La Figure 25 montre quelques exemples de remplissage de type bitmap avec les propriétés 
utilisées.

Figure 25 : Exemples de remplissage de type bitmap
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Ombre
Les ombres peuvent être appliquées aux lignes, aux formes et au texte.

Vous pouvez appliquer rapidement une ombre à l'objet sélectionné en utilisant l'icône Ombre  
de la barre d'outils Ligne et remplissage. Cependant, l'ombre appliquée ne sera que celle définie 
par défaut. Pour bénéficier de plus d'options, utilisez l'onglet Ombre de la boîte de dialogue 
Remplissage (Figure 26).

Cochez l'option Appliquer l'ombre pour accéder aux propriétés de l'ombre portée sur l'objet 
sélectionné.

Figure 26 : Onglet Ombre

Position
Permet de sélectionner le point qui va indiquer la direction dans laquelle l'ombre va être portée.

Attention
Si vous sélectionnez le point du milieu, aucune ombre n'est appliquée et la distance 
est réduite à 0.

 Distance
Détermine la distance entre l'objet et son ombre.

Couleur
Permet de choisir la couleur de l'ombre dans la liste déroulante.

Transparence
Détermine de pourcentage de transparence de l'ombre.

Transparence
Pour régler la transparence de l'objet sélectionné, utilisez l'onglet Transparence de la boîte de 
dialogue Remplissage (Figure 27).
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Figure 27 : Onglet Transparence

Deux types de transparence sont disponibles : la transparence uniforme et la transparence en 
dégradé.

Pour créer une transparence uniforme, cochez Transparence et saisissez le pourcentage désiré.

Pour créer une transparence en dégradé, cochez Dégradé et saisissez les paramètres du 
dégradé. Une explication de ces paramètres est fournie dans "Créer des dégradés personnalisés" 
page 25.

Modifier la transparence d'un objet
Vous pouvez également créer une transparence en dégradé pour un objet avec la souris. Pour 
ceci, faites afficher la barre d'outils Mode (Figure 28).

Figure 28 : Barre d'outils Mode

Attention
Cette modification n'est possible qu'avec des objets de type courbe. Faites un clic 
droit sur l'objet et choisissez Convertir > En courbe si nécessaire.

Sélectionnez un objet et cliquez sur l'icône Transparence . L'axe du dégradé apparaît en 
pointillés avec, à chacune de ses extrémités, un carré de la couleur correspondante (Figure 29). 
Vous pouvez alors déplacer chacun de ses points pour obtenir le dégradé que vous souhaitez. Les
valeurs des propriétés de l'onglet Transparence de la boîte de dialogue Remplissage sont mises à 
jour. Il n'est pas possible de déplacer le point de départ de l'axe d'un dégradé de transparence de 
type Axial.
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Figure 29 : Effet du déplacement de l'axe du 
dégradé de la transparence

Créer de nouveaux remplissages

Bien que vous puissiez modifier les caractéristiques d'un remplissage existant, en cliquant sur le 
bouton Modifier, il est recommandé de créer de nouveaux remplissages, et de ne modifier que les 
remplissages personnalisés et non les remplissages prédéfinis. Cela vous évitera de voir vos 
modifications écrasées lors d'une mise à jour de LibreOffice.

Vous pouvez enregistrer la liste des remplissages d'un type donné avec l'icône , Enregistrer la
liste des dégradés par exemple, afin de pouvoir utiliser un remplissage que vous venez de créer 
dans un autre document. La boîte de dialogue Enregistrer sous s'ouvre, où vous pouvez saisir un 
nom de fichier.

Pour utiliser une liste de remplissage préalablement enregistrée, utilisez l'icône , Charger la 
liste des dégradés par exemple, et sélectionnez le fichier dans la boîte de dialogue Ouvrir. 
Cliquez sur OK et la liste des remplissages sera disponible dans votre document.

Créer des couleurs de remplissage personnalisées
Vous pouvez créer des couleurs personnalisées, ou modifier des couleurs existantes, dans l'onglet
Couleur de la boîte de dialogue Remplissage (Figure 30).

Figure 30 : Créer une couleur de remplissage
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Vous pouvez définir une couleur en spécifiant ses attributs RVB (Rouge, Vert, Bleu) sur une 
échelle de 0 à 255, ou CMJN (Cyan, Magenta, Jaune, Noir) de 0 à 100 %. Saisissez les valeurs 
correspondant à la couleur désirée.

Pour créer une nouvelle couleur, saisissez son nom. Spécifiez les attributs selon le système de 
couleur que vous avez choisi. Cliquez enfin sur Ajouter. La couleur est ajoutée dans la liste 
déroulante et dans la table standard.

Pour modifier une couleur, sélectionnez-la dans la liste déroulante ou dans la table standard. 
Spécifiez ses nouveaux attributs, puis cliquez sur Modifier.

Vous pouvez également, après avoir choisi une couleur, cliquez sur le bouton Éditer. La boîte de 
dialogue Sélecteur de couleur s'ouvre (Figure 31).

Figure 31 : Éditer une couleur

Vous pouvez ici sélectionner une couleur en cliquant dans les zones de couleurs (un clic dans la 
barre verticale permet de se positionner dans une tonalité approximative, et un clic dans la zone 
carrée permet de choisir une couleur précise), ou en saisissant des valeurs dans la partie droite de
la boîte de dialogue, pour les paramètres RVB, TSB (Teinte, Saturation, Brillance) ou CMJN.

Les zones de couleur du côté gauche sont directement reliées aux champs de saisie du côté droit ;
si vous sélectionnez une couleur dans les zones de couleur, les valeurs sont mises à jour 
instantanément. Les deux zones de couleurs qui forment une barre horizontale affichent la couleur 
sélectionnée à droite et sa nouvelle définition à gauche.

Modifiez les composants de la couleur comme vous le souhaitez et appuyez sur OK pour sortir de 
la boîte de dialogue.

Vous pouvez incorporer les couleurs dans le document en cochant l'option Incorporer. Vous 
pouvez également enregistrer la liste des couleurs dans un fichier ayant comme extension .soc.
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Astuce
Vous pouvez également créer des couleurs personnalisées avec Outils > Options
> LibreOffice > Couleurs. Les couleurs ainsi créées sont disponibles pour tous 
les documents dans tous les modules de LibreOffice.

Créer des dégradés personnalisés
Vous pouvez créer des dégradés personnalisés, ou modifier des dégradés existants, dans l'onglet 
Dégradés de la boîte de dialogue Remplissage (Figure 32).

Figure 32 : Créer un dégradé

Il est recommandé de conserver les dégradés prédéfinis tels quels et de les utiliser plutôt comme 
point de départ pour créer de nouveaux dégradés, en modifiant les couleurs de départ et d'arrivée 
par exemple.

Il existe plusieurs types de dégradés, comme le montre la Figure 33. Les paramètres du dégradé 
sont décrits Tableau 2 : certains paramètres seront indisponibles selon le type choisi.
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Figure 33 : Types de dégradés

Tableau 2. Propriétés du dégradé

Propriété Signification

Centre X Pour les types Radial, Ellipsoïde, Carré et Rectangulaire, positionne le 
centre du dégradé sur l'axe X, en pourcentage de la largeur de l'objet.

Centre Y Pour les types Radial, Ellipsoïde, Carré et Rectangulaire, positionne le 
centre du dégradé sur l'axe Y, en pourcentage de la hauteur de l'objet.

Angle Pour les types Linéaire, Axial, Ellipsoïde, Carré et Rectangulaire, 
spécifie l'angle de l'axe du dégradé par rapport à l'axe horizontal.

Bordure Spécifie le pourcentage de l'axe du dégradé à partir duquel le dégradé 
commence (0 % : au début de l'axe ; 100 % : à la fin de l'axe).

De Indique la couleur de départ du dégradé. Le pourcentage correspond à 
l'intensité de la couleur, de 0 % pour le noir à 100 % pour l'intensité 
maximale.

À Indique la couleur d'arrivée du dégradé. Le pourcentage correspond à 
l'intensité de la couleur, de 0 % pour le noir à 100 % pour l'intensité 
maximale.

Pour créer un nouveau dégradé, spécifiez son type et ses attributs. Cliquez sur Ajouter et 
saisissez son nom, puis cliquez sur OK. Le dégradé est ajouté dans la liste déroulante.

Pour modifier un dégradé, sélectionnez-le dans la liste déroulante. Spécifiez son nouveau type et 
ses nouveaux attributs, puis cliquez sur Modifier.

Vous pouvez enregistrer la liste des dégradés dans un fichier ayant comme extension .sog.

Modifier le dégradé de remplissage d'un objet
Vous pouvez modifier certains attributs du dégradé de remplissage d'un objet sans définir de 
dégradé personnalisé. Pour ceci, faites afficher la barre d'outils Mode (Figure 34).
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Figure 34 : Barre d'outils Mode

Sélectionnez un objet rempli avec un dégradé et cliquez sur l'icône Dégradé . L'axe du dégradé
apparaît en pointillés avec, à chacune de ses extrémités, un carré de la couleur correspondante 
(Figure 35). Vous pouvez alors déplacer chacun de ses points pour obtenir le dégradé que vous 
souhaitez. Les valeurs des propriétés de l'onglet Dégradés de la boîte de dialogue Remplissage 
sont mises à jour, mais ne sont pas enregistrées comme propriétés du dégradé de la liste 
déroulante. Il n'est pas possible de déplacer le point de départ de l'axe d'un dégradé de type Axial.

Figure 35 : Effet du déplacement de l'axe du dégradé

Créer des hachures personnalisées
Vous pouvez créer des hachures personnalisées, ou modifier des hachures existantes, dans 
l'onglet Hachure de la boîte de dialogue Remplissage (Figure 36).

Figure 36 : Créer une hachure de remplissage

Il est recommandé de conserver les hachures prédéfinies telles quelles et de les utiliser plutôt 
comme point de départ pour créer de nouvelles hachures. Les paramètres d'une hachure sont 
décrits Tableau 3.
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Tableau 3. Propriétés d'une hachure

Propriété Signification

Espacement Spécifie l'espacement entre deux lignes de hachure.

Angle Spécifie l'angle des lignes de hachure par rapport à l'axe horizontal. 
Vous pouvez également utiliser la miniature en dessous pour 
spécifier un angle multiple de 45 degrés.

Type de ligne Indique l'utilisation d'une ligne simple ou de lignes croisées ou triples 
comme motif de hachure.

Couleur de ligne Permet de sélectionner la couleur de la ligne de hachure dans la liste 
déroulante.

Pour créer une nouvelle hachure, spécifiez ses attributs. Cliquez sur Ajouter et saisissez son nom,
puis cliquez sur OK. La hachure est ajoutée dans la liste déroulante.

Pour modifier une hachure, sélectionnez-la dans la liste déroulante. Spécifiez ses nouveaux 
attributs, puis cliquez sur Modifier.

Vous pouvez enregistrer la liste des hachures dans un fichier ayant comme extension .soh.

Créer et importer des images bitmap
Vous pouvez ajouter (importer) de nouvelles images de remplissage ou créer vos propres motifs, 
dans l'onglet Bitmaps de la boîte de dialogue Remplissage (Figure 37).

Figure 37 : Créer un nouveau motif bitmap

Pour créer un motif de remplissage :

1) Sélectionnez l'image bitmap Vide dans la liste déroulante pour activer l'éditeur de motif.

2) Choisissez les couleurs de premier plan et d'arrière-plan dans les listes déroulantes.
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3) Dessinez le motif en cliquant dans un carré (pixel) de la grille de l'éditeur de motif, avec le 
bouton gauche de la souris pour lui attribuer la couleur de premier plan et avec le bouton 
droit pour lui attribuer la couleur d'arrière-plan. Vous pouvez contrôler le résultat obtenu 
dans l'aperçu.

4) Cliquez sur Ajouter, saisissez le nom de votre motif et cliquez sur OK pour ajouter le motif 
dans la liste déroulante des images bitmap.

Vous pouvez également importer une image existante en cliquant sur Importer, en choisissant le 
fichier image et en saisissant son nom.

Vous pouvez enregistrer la liste des images bitmap dans un fichier ayant comme extension .sob.

Utiliser les styles

Supposez que vous vouliez appliquer le même remplissage et la même largeur de bordure et de 
ligne à un ensemble d'objets. Cette procédure répétitive peut être simplifiée par l'utilisation des 
styles. Cette fonctionnalité vous permet de définir un format modèle (un style) et ensuite de 
l'appliquer à plusieurs objets. Pour plus d'informations sur les styles, voir le Chapitre 6 
(Introduction aux styles) du Guide Writer.

Cliquez sur l'icône Styles et formatage  de la barre d'outils Ligne et remplissage ou appuyez 
sur la touche F11 pour ouvrir la boîte de dialogue Styles et formatage, puis cliquez sur l'icône 

Styles d'images  en haut à gauche (Figure 38). La liste des styles utilisables pour les objets 
graphiques apparaît.

Figure 38 : Boîte de dialogue Styles et formatage
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Styles d'image liés
Les styles d'image permettent l'héritage. En d'autres termes, un style peut être lié à un autre style 
(parent) afin d'hériter de ses attributs de formatage. Vous pouvez utiliser cette fonctionnalité pour 
créer des familles de styles.

Par exemple, si vous avez besoin de plusieurs rectangles qui ne diffèrent que par leur couleur de 
remplissage, la meilleure façon de procéder est de définir un style générique pour la forme 
rectangle qui définit les bordures, le type de remplissage, la police, etc. Puis créez des styles liés à
ce premier style, qui ne diffèrent que par la couleur de remplissage. Ainsi, si vous n'avez besoin de
modifier que l'épaisseur de la bordure, vous pouvez ne le faire que dans le style parent, et les 
autres styles liés vont changer en conséquence.

Créer des styles d'image
Assurez-vous que l'icône Styles d'images est sélectionnée.

En utilisant la boîte de dialogue Styles d'images
1) Sélectionnez, si vous le souhaitez, le style à partir duquel vous voulez créer un nouveau 

style.

2) Faites un clic droit et choisissez Nouveau dans le menu contextuel pour ouvrir la boîte de 
dialogue Styles d'images (Figure 39). Si vous aviez sélectionné un style, vous allez lier le 
nouveau style à ce style de départ. Si vous n'avez pas sélectionné de style, le nouveau 
style sera lié au style Standard.

Figure 39 : Boîte de dialogue Styles d'images

3) Attribuez au nouveau style un nom significatif.

4) Utilisez les différents onglets de la boîte de dialogue Styles d'images pour fixer le format du
nouveau style.

5) Cliquez sur OK pour enregistrer le nouveau style.

Les onglets de la boîte de dialogue Styles d'images peuvent être regroupés de la manière 
suivante :

• L'onglet Gérer contient un résumé du style et sa position hiérarchique.

• Les onglets Police, Effets de caractère, Retraits et espacement, Alignement, Tabulations et 
Typographie asiatique contiennent les propriétés du texte inséré dans une zone de texte ou
un objet graphique.

• L'onglet Cotation contient les propriétés des lignes de cotation.

• Les onglets Texte, Animation de texte, Connecteur, Ligne, Remplissage, Ombrage et 
Transparence contiennent les propriétés de formatage des objets graphiques.
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En utilisant l'objet sélectionné
Vous pouvez créer un nouveau style à partir d'un objet déjà formaté, qui peut être un texte ou un 
objet graphique :

1) Sélectionnez l'objet que vous voulez utiliser.

2) Ouvrez la boîte de dialogue Styles et formatage et cliquez sur l'icône Nouveau style à 

partir de la sélection  en haut à droite.

3) Dans la boîte de dialogue Créer un style qui s'ouvre, saisissez le nom du nouveau style. La
liste affiche les styles personnalisés disponibles.

4) Cliquez sur OK pour enregistrer le nouveau style.

Modifier un style d'image
Dans la boîte de dialogue Styles et formatage, faites un clic droit sur le style d'image que vous 
voulez modifier et choisissez Modifier dans le menu contextuel. La boîte de dialogue qui s'ouvre 
est la même que celle pour créer un style d'image. Faites les modifications voulues, puis cliquez 
sur OK pour les enregistrer.

Mettre à jour un style d'image à partir d'une sélection
Pour mettre à jour un style d'image à partir de l'objet sélectionné, choisissez le style d'image dans  
la boîte de dialogue Styles et formatage que vous voulez mettre à jour, puis cliquez sur l'icône 

Actualiser le style  qui se trouve en haut à droite. Cette méthode applique directement, et 
sans demande de confirmation, les attributs de l'objet sélectionné au style choisi ; la modification 
ne peut être annulée. Vous pouvez aussi choisir Éditer le style d'objet dans le menu contextuel 
d'un objet sélectionné : le dialogue s'ouvre et toutes les options sont accessibles.

Appliquer des styles d'image
Vous pouvez appliquer un style d'image de deux façons à partir de la boîte de dialogue Styles et 
formatage :

• Sélectionnez l'objet et double-cliquez sur le nom du style que vous voulez lui appliquer.

• Cliquez sur l'icône Mode Tout remplir . Le curseur de la souris change de forme. 
Positionnez-le sur l'objet dont vous voulez modifier le style et cliquez sur le bouton gauche.
Ce mode reste actif jusqu'à ce que vous le désactiviez, et vous pouvez donc appliquer le 
même style à plusieurs objets successivement. Pour désactiver le mode Tout remplir, 
cliquez à nouveau sur l'icône Mode Tout remplir ou appuyez sur Échap.

Attention Lorsque le mode Tout remplir est actif, un clic droit n'importe où dans le document 
annule la dernière action de ce mode. Faites attention à ne pas faire 
involontairement de clic droit et ainsi d'annuler des actions que vous voudriez 
conserver.

Astuce
En bas de la boîte de dialogue Styles et formatage se trouve une liste déroulante. 
Vous pouvez choisir d'afficher tous les styles ou seulement les styles appliqués ou 
les styles personnalisés.

Supprimer des styles d'image
Vous ne pouvez pas supprimer un style prédéfini de Draw, même si vous ne l'avez pas utilisé. 
Vous ne pouvez supprimer que les styles personnalisés. Cependant, avant de le faire, vérifiez que 
le style d'image ne soit pas utilisé. Si c'est le cas, remplacez-le par un style de substitution.
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Pour supprimer un style d'image personnalisé, faites un clic droit sur le style dans la boîte de 
dialogue Styles et formatage et choisissez Supprimer dans le menu contextuel. Un message de 
confirmation apparaîtra.

Appliquer des effets spéciaux

Un certain nombre d'effets spéciaux peuvent être appliqués à un objet dans Draw. Plusieurs 
d'entre eux sont disponibles dans la barre d'outils Mode (Figure 40). Si cette barre d'outils n'est 
pas visible, allez dans Affichage > Barre d'outils > Mode.

Figure 40 : Barre d'outils Mode

Pour les informations sur la rotation des objets, voir Chapitre 3 (Manipuler les objets et les points 
des objets). Pour les informations sur la révolution des objets en 3D, voir Chapitre 7 (Manipuler 
des objets 3D).

L'utilisation de l'outil Transparence est expliquée dans "Modifier la transparence d'un objet" page
22.

L'utilisation de l'outil Dégradé est expliquée dans "Modifier le dégradé de remplissage d'un objet" 
page 26.

Retourner des objets
La méthode la plus simple pour retourner un objet est de le sélectionner, de faire un clic droit et de 
choisir Refléter > Verticalement ou Refléter > Horizontalement dans le menu contextuel. Vous 
pouvez trouver également ces commandes dans le menu Modifier.

L'outil Retourner de la barre d'outils Mode peut aussi être utilisé. Cet outil vous permet de modifier
la position et l'angle de retournement (Figure 41).

1) Cliquez sur l'objet graphique à retourner. Les poignées de sélection apparaissent.

2) Cliquez sur l'icône Retourner . L'axe de symétrie apparaît sous la forme d'une ligne de 
pointillés au milieu de l'objet. L'objet sera retourné autour de cet axe.

3) Déplacez une ou les deux extrémités en les faisant glisser avec le bouton de la souris pour
déterminer l'orientation de l'axe de symétrie.

4) Placez le curseur de la souris au-dessus d'une poignée de sélection de l'objet afin que sa 
forme change.

5) Cliquez et faites glisser le curseur de l'autre côté de l'axe de symétrie. Une image fantôme 
de l'objet retourné apparaît.

6) Relâchez le bouton de la souris et l'objet retourné apparaîtra.

Si vous gardez appuyée la touche Maj durant le déplacement de l'axe de symétrie, l'angle de cet 
axe est limité aux multiples de 45 degrés. Ceci est le comportement par défaut de la touche Maj. 
Cependant, si l'option Lors de la rotation de la section Enclencher de Outils > Options > 
LibreOffice Draw > Grille est cochée, l'action de la touche Maj est inversée. L'angle de l'axe est 
limité aux multiples de 45 degrés, à moins que la touche Maj ne soit appuyée.

Pour obtenir l'effet miroir d'un objet graphique, dupliquez-le, puis retournez la copie.
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Figure 41 : Retournement d'un objet

Déformer un objet

Sélectionnez l'objet à déformer et cliquez sur l'icône Déformer . Un message vous demandera 
de convertir l'objet en courbe si ce n'est pas déjà fait ; cliquez sur Oui pour pouvoir continuer. 
Cliquez et faites glisser une poignée de sélection pour déformer l'objet (Figure 42). L'effet sera 
différent selon la poignée sélectionnée.

Figure 42 : Déformer un objet

Positionner sur le cercle (en perspective)
Sélectionnez l'objet à déformer et cliquez sur l'icône Positionner sur le cercle (en perspective)

. Un message vous demandera de convertir l'objet en courbe si ce n'est pas déjà fait ; cliquez 
sur Oui pour pouvoir continuer. Cliquez et faites glisser une poignée de sélection pour déformer 
l'objet (Figure 43).
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Figure 43 : Positionner un objet sur un cercle (en perspective)

Positionner sur le cercle (incliner)

Sélectionnez l'objet à déformer et cliquez sur l'icône Positionner sur le cercle (incliner) . Un 
message vous demandera de convertir l'objet en courbe si ce n'est pas déjà fait ; cliquez sur Oui 
pour pouvoir continuer. Cliquez et faites glisser une poignée de sélection pour déformer l'objet 
(Figure 44).

Figure 44 : Positionner un objet sur un cercle (incliner)
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